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CHAPTER
ONE

INTRODUCTION

Redescription mining is a powerful data analysis tool that aims at finding alternative descriptions of the same entities.

For example, in biology, an important task is to identify the bioclimatic constraints that allow some species to survive,
that is, to describe geographical regions in terms of both their bioclimatic conditions and the fauna that inhabit them.

Siren is a tool for interactive mining and visualization of redescriptions. It is based on the ReReMi mining algorithm.
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CHAPTER
TWO

GETTING STARTED

Siren allows you to interactively mine and visualize redescriptions from your data.

We outline here some high-level interactions offered by Siren.

2.1 Importing data

After you get Siren installed and running, it will open the rools window, with tabs for variables and redescriptions, all
of them empty. Hence, the first thing to do is to import data or open an existing siren package to start working.

If you already have some siren package (i.e. with a . siren extension) you can open it via the interface menu File —
Open.

Otherwise, or if you want to work on a new data set, you can import data to Siren, this will populate the Entities
and Variables tabs.

2.2 Mining redescriptions from scratch

Once the two sets of variables are loaded and can be seen in the tabs you may want to let the tool mine redescriptions
in an fully automated way, using currently enabled variables. The menu entry Process — Mine redescriptions let you
do just that.

Alternatively, if both queries in a visualization are empty Siren simply mines redescriptions on your data when clicking
on the Expand button.

Results will be appended to the redescriptions list in the Expansions tab.

Before running a mining task make sure you have adjusted the mining preferences...

2.3 Expanding a redescription

You can also press the expansion button to automatically find expansions of any redescription your are currently
visualizing and editing. Siren will try to append literals to the current redescription, using the enabled variables.

Again, results will be appended to the redescriptions list in the Expansions tab.

Before running an expansion task make sure you have adjusted the mining preferences...
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2.4 Filtering redescriptions

A list of redescription can be filtered automatically. That is, the algorithm will go through the redescriptions, from top
to bottom in the current order, an check for each redescription, whether it is redundant given the previous ones. If a
redescription is found redundant it will be disabled. This is done via the interface menu Edit — Filter redundant.

It is also possible to select a redescription and filter following redescriptions which are redundant to that particular
redescription only, via the interface menu Edit — Filter redundant to current.

2.5 Exporting redescriptions

The redescriptions from the Redescriptions tab can be exported under different formats.

2.6 Saving as a package

You can save your current project, i.e. the data, current redescription list and preferences as a siren package (i.e. with
a . siren extension) via the interface menu Edit — Save as...

If you continue working on the current project you can save changes to the current siren package via the interface
menu Edit — Save.

Existing siren packages can be opened via the interface menu File — Open.

4 Chapter 2. Getting Started



CHAPTER
THREE

INTERFACE

3.1 Siren Windows and Tabs

Siren has two types of windows: tools and view, which are presented below.

Entiies | LS Varlables | R Varlables | Redescriptions | Expansions | History  Log

aquery
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3.1.1 Tools window

The Tools window is unique, it is the main siren window. It contains several tabs.

SIREN :: tools

Entities = LHS Variables RHS Variables | Redescriptions | Expansions = History Log

‘ | ‘ id ‘ auerv LHS | auerv |

¢ The Entities tab contains the list of entities.

Entities | LS Variables | RHS Variables _ Redescriptions

Il !lllH w T — [ \. [
Il
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Two tabs contain lists of variables.
¢ The LHS Variables tab,

¢ and the RHS Variables tab contain the list of left-hand side variables and right-hand side variables respectively.
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Entities | LHS Variables | RHS Variables _Redescriptions

W nome 1 type | density
5 ) 134 whitetailed deer ER 3
0 O lean 02 Sorting criterion
1 & e Water deer Boolean 0.0047
12 @
13 B 5 UralField Mouse Boolean q
14 B 91 TundraVole Boolean 01219 Selected variable
15 [0 78 mistram's sid Boolean [0.0000
16 W 56 Thomas's PineVole Soolean 00124
7 R oss < Enabled variable
8 W 172 Teigashrew Boolean 00171
19 R4 a4 StipedFieldouse Boolean 02012
20 A 106 stoat Boolean 0.5759. " .
BT [ior sweppero — Disabled variable
2 (2 104 Steppemouse Boolean 00361
2 (4 178 Speckled groundsquirrel Boolean 00013
24 |2 185 SpanishMole Boolean 00497
25 |4 23 Spanishibex Boolean 00167
26 ) 10 SouthwesternWaterVole Boolean 0.1452
27 | 50  SouthernWhite-breasted Hedgehog Boolean 01942
8 W %2 Sowthemvole Boolean 00536
25 W 166 SouthemBirchMouse Boolean 00066
3 W S8 SmellasianMongoose Boolean 00023
31 W 28 skaDeer Boolean 00416
32 W 3 sidlanshiew Boolean 00039
33 B 188 siberian chipmunk Boolean 0.0066
34 B 151 siberian Flying Squirrel Boolean 0.0416.
35 W s serotinebat Boolean 03573

Loading done

Three tabs contain lists of redescriptions.

* The Redescriptions tab is the main list of redescriptions. Redescriptions are imported and exported to and from
that list.

» The Expansions tab lists redescriptions that have been generated by mining or extending queries.

* The History tab lists all edits made to queries, allowing to undo changes.

Entities | LHS Variables ~ RHS Variables | Redescriptions

id query LHS IEn| T track
1 M r7 ‘Wood mouse 1712 0:81:14,18,
2 M ri12 Roe Deer 1604 0:24;1:24,31
3 a |r7 164;1
a O E 0:174;1:1,5
s O
6 M ris European Hare 210821 1 (15200 260775 0.0 0:66:1:26,3C
7 MR stoat ([11.65t8+5253] D|sabled redescnptlon
8 M r13 Common Shrew St7+528.7]A [ivoes [l
5 2 R Fieldvole 4.5] A [qz;mmm Trloza loo 1322
10 B2 R0 EuropeanPine Marten
11 |4 R EuropeanHedgehog Selected redescription 0:51;1:15,1€
12 4 R22  EurasianWater Shrew $269]A [433335p8-)v [120739 00 1300 0127118
13 4 R36  EuropeanPolecat o 01101141
16 W RIS widboar (rs1=uirstooa - Enabled redescription  oisorio
15 M Rs2 European Otter ([4.95t7-514.0] A [1.8st9-<9.8/ A |10.4¢0582 0.0 1205 0:69,1:6,83
16 M Ras Common Pipistrelle ([t7-517.3] A [8.0stds]n [7.61335t1-510.645 0.0 1197 0:145,1:6,1%
17 M R European Water Vole [108<t1+<7.1]A [17.55t7+]A [9.95t9+ 0706 0.0 188 0111216
18 M R Beech Marten ([1055t1-557] A [209st8+]) v [5.25t30728 0.0 N7 075:1:0,14,
19 M R8s European Mole ([14.45t9+5247) A [35.55p5-1A [4255 0762 0.0 1162 0:184,1:20,%
0 WM ra European Rabbit ([0.73755t3-] v [127.67 <p5-<155.08]) A 0.655 0.0 1087 0:136:1:14,1
21 M r33 ‘Yellow-necked Mouse ([18.8<t8+<28.1] v [17.45t104521.6)) A 0.693 0.0 998 0:6;1:0,19,2
22 |4 R0 Housemouse (35St A [44<t2])v [350715t3-50.758 00 992 0:1011:12,1
23 4 RSt Redbeer ([t10-57.4] A [9.15t10+5186)) v [33.1510601 00 972  027:19,18,
24 |4 R32  Brownlongeared bat ([1375t9+522.7] v [841115t11-5864440.693 00 963  0:147:1:183
25 |4 R23  CommonVole ([2055t8+<28.5] A [t11~<9.175] A [43.800.734 00 888  0821:151¢
26 [/ R2¢  CommonVole ([9.55t4+<9.5]v [205<t8+=285))A (10734 00 888  0821:151¢
27 M Rao Daubenton's Bat A Eurasian Pygmy Shrew  (([14.05t5+<20.6] A [48.75<p8~<159.83]0.666 0.0 875 0:120,174;1
Losding done

Finally,

* the Log tab contains logging output generated by the mining algorithm.

Entities LS Variables RS Variables | Redesciptions | Expansions | History | Log
Redescription: 0+ 46terms: (3):1 18>14.024.4822>-5.3¢6.3 0758857142857 1.11022302463¢-16 64 147 664
tension  RHS extension Score  Accuracy QuerypV Redpv _toBlue toRet
+&41>34714<11838 400350823 07939394 00001385 00000000 655 57
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ot151221:18

Extensions Batch
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+ 8185140204 oTTidzss | 0000000 | o00u000o ers 147

L Sanans  sootnans oTissIz 0000000 00060000 10

Extensions Batch:
Redescrptom 0+ 4Sterms: (41 16-14.024.4822> 535638 413471411838 0 655
et Queypy Redpu  tomls toRed
25011393 400063057 0.8002451  0.0000000  0.6000000 653 85
2 psedrerasn T oatasier GpoTsos - bo000000 00b000a0 12 1

Extensions Batc!

Redescription: 0+ 45terms: (4): 1 22>-5.3<6.3|24>-2.8667<-2.86 & 18>14.0424.4 0.771428571429 1.11022302463¢-16 53 147 675 -~ 0:1;151:22,1:2,1:18
tension  RHS extension score  Accuracy QuerypV RedpV  toBlue toRed

+841534714€11838 400358442 0.8072727  0.0001059  0.0000000 666 57

* ]25>035<035 400114286 07828571 0.0000000  0.0000000 10 O

Extensions Batc!

Redescription: 0+ 44terms: (4): 1 18>14.0<24.48 22>-5.3¢6.3 | 24>2.8667<2.86 0770547945205 1.11022302463¢-16 53 148 675------ 0:1;1:1:22,1:181:24
tension RHS extension Score  Accuracy QuerypV Redpv toBlue toRed

+ 8425245513375 400168630 0.7674109  0.0000000  0.0000000 663 114

>035c035  +00114155 07819635  0.0000000  0.0000000 10 0O

Extensions Batc}
Redescrpton0  45terms: (91, 2275363 24> 20667286 25-035<035 0714581170908 110223024636-1637 239681+
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Extensions Batd
Redescrpton0  4sterms: (31 18:14,02448.22-53:63 036
LHs extension Acurac Messages from the mining processes
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N |1008<0.8 00083601 05543672 00000685  0.0000000 3 22
Extensions Batch
Redescrption 0+ 45terms: (41 16-14.0<2448.22>5,366.38 £3-52.333105.0 0758127438231 1110223024636 1652 10453
LHS extension Accurscy Querypl RedpV  toBle ofed
e 2a oo s003s4Es 0796370 05000000 52
L Mm0baTe W00l O7ieAZ 00000000  G00000a0

0:;1:18,22,1:03

Tabs can be shown or hidden via the interface menu Windows — Tabs.

The main means to manipulate variables or redescriptions, depending on which tab you are currently viewing, are
available via the Edit menu and the contextual menu opened by right click.

List items can be enabled/disabled by checking/unchecking the corresponding box in the left column. All items in a
list can be enabled/disabled simultaneously. Lists can be sorted based on the value of the different fields displayed by
clicking on the column header.

6 Chapter 3. Interface
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Redescriptions can be cut, copied, and pasted from and to different positions in the lists and from one list to the other
and vice-versa. All disabled redescriptions can be deleted at once.

3.1.2 View window

A view window allows to visualize a redescription, to edit it and launch mining and expansion. Several views of
different types of the same redescription can be opened simultaneously. They are linked together an to the original
redescription in the list so that edits and selections made in one view are reflected in the list and other views.

A vView window can be opened with a double click on a variable or redescription in a list from the Tools window.

& SIREN :: R8 Entities Multidimensional Scaling

Figure

—15 -10 -5 1] 5 10

Moose
([9.8=<t2+<0.4] A [12.2<t7+<24.6] A [56.852<p8~

Editable queries

J= 0.814 |Eso] = 83 138

pvalie= 0000 [E\Ewl= 715 |- REdescription statistics
Onlyable: & Types: Boolean || Categorical | | Numerical &
Rlesiies 100 o Settings controls

- opac. gisabled +

ﬁ 4-}» e, B E Expand Reproject

Both queries can be edited using the text boxes. If the syntax of a query is incorrect, Siren will not be able to parse
it and it will fall back on the previous correct query. Queries are parsed when ENTER is pressed, in order to avoid
parsing error due to partial edits.

Redescriptions statistics are shown below the queries.

In case of projections, setting controls allow to set parameters and the data can be projected anew by clicking the
Reproject button.

Sliders allow to set the opacity of disabled entities, as well as the level of details for parallel coordinates plots.

Expansion can be started by pressing the Expand button. The expansion will be delegated to a background process.
It can be interrupted via the menu Process — Stop expander XXX, where running task are listed. Redescriptions
generated during the expansion will be appended to the list of redescriptions in the Expansions tab.

3.2 Menu

The main menu of Siren is at the top of the Tools window.

Here is a summary of functionalities available throught the menu.

3.2. Menu 7
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3.2.1 File

The F1ile submenu provides import, export, opening and saving functionalities and setting the preferences.

SIREN = File Edit View P

Open

4 [variables | Redescriptions
ST ot Data
L3

Import Prefere|

Quit

3.2.2 Edit

The content of the Edit submenu depends on the tab or view currently active.
If the tab contains redescriptions, it will also allow to filter the redescription and to copy, cut and paste them.

These functionalities can also be accessed via the contextual menu on right-click.

[16.694 <t3~ <
[-4.5st10+<-1
[1.0<t9+<3.5]
[9.6 <td+=<-5.t
[11.9st3+2-7
(([2.95t3+] v

([9.8=t2+=0.
([11.6<t8+<2

SIREN :: File Edit View P
— -

3.3 Views

If the tab contains redescriptions or variables the View menu will allow to open a view window to visualize the selected
item.

8 Chapter 3. Interface
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SIREN : File Edit V'*ew Pr.

bnsions  History

[18.8<t8+=2
([3.5=t14] A
[t10-<7.4] A
[13.7st9+ 22
[20.5<t8+<2

(
(
(
(
(
(
(
(

[9.5=<ta+=9.!

Daubenton's Bat A EurasianPygmy Shrew  (([14.0<t5+ <!
Muskrat [5.5st3+<-2

R26& American Mink ffloa<th+<?

3.4 Process

The Process menu allows to start mining redescriptions and contains a list of running task and allows to interrupt
any of them.

File Edit View Proc

Expansions

[9.8st2+<0.4

M

kA |E3 Moose v Polar bear [9.8<t2+<0.4
kA E4 Moose [9.8<t2+<0.4
kA |E5 Moose [9.8<t2+<0.4
&/ E6 Moose [9.8=t2+<0.4
& E7 Moose ([9.8=<t2+=<0.
i/ E8 Moose v Polar bear [9.8<t2+<0.4
& E9 Moose v Polar bear [9.8<t2+<0.4
2 lcan [P MTae_ta -n

SIREN = File Edit View Pr

e SIREN

3.5 Windows

The Windows menu contains a list of tabs and allows to show or hide any of them. It also contains a list of Views
currently opened sorted by redescription, allowing to access any of them and close all at once.

SIREN = File Edit View Pr

3.4. Process 9
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3.6 Help

The He 1p menu provides access to this help and to more information about Siren and licensing.

File Edit dc Help

LHS Variables | RHS Variable kanen ctrl+H
t

Entities

& Polar bear [16.694 <t3~=<
&4 R3 Polar bear [-4.5<t10+<-1
W R4 Polar bear [1.0=<t9+<3.5]
& RS Polar bear [9.6cta+=-5.¢
KA R6 Polar bear [11.9<t3+<7
kA R7 Wood mouse (([29=t3+4] v
&4 RS Moose ([0.8st2+<0.
& [R9 Stoat (M.6<st8+=2
KA R10 Bank Vole [149<t6+<27

10
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CHAPTER
FOUR

FORMATS

4.1 Data formats

For redescription mining, one considers entities discribed by variables divided into two sets, hereafter arbitrarily
called left-hand side and right-hand side. This can be seen as a pair of data matrices, where entities are identified
with rows and variables with columns. Both sets of variables describe the same entities, hence, the matrices have the
same number of rows.

In Siren, data include:
 Variables: The variables describing the entities are divided in two sets. They can be of three types:
1. Boolean,
2. categorical,
3. or real-valued.
Obviously, this is required.
 Entities names: Optional additional information, providing names for the entities.
 Variable names: Optional additional information, providing names for the variables.

* Coordinates: Optional location information, i.e. geographic coordinates of the entities. This makes the data
geospatial.

Data can be imported to Siren via the interface menu File — Import — Import Data. Below, we present the data
formats supported by Siren.

Data can be imported into Siren as CSV files. The program expects a pair of files, one for either side in character-
separated values, as can be imported and exported to and from spreadsheet programms, for instance.

There are two main formats,

¢ Full: standard table format, or

* Sparse: compact format for dataset with few non-zeros entries.
The two data files need not be in the same format.

If entities names and/or coordinates are provided, they will be used to match entities across the two sides. Otherwise,
rows will be match in order and an error will occur if the two side do not contain the same number of rows.

11
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4.1.1 Full format

The data is stored as a table with one column for each variable and one row each entity. The first row can contain the
names of the variables. The entities names can be included as columns named ids. Similarly the coordinates can be
included as a pair of columns named longitudes and latitudes, respectively.

4.1.2 Sparse format

This format allows to store data that contains few non-zero entries more compactly, as in the Matlab sparse format (or
like the edge list of a bipartite graph).

Each line contains an entry of the data as a triple (entity, variable, value). This way, the data is stored as in three
columns and as many rows as there are entries. In this case the first line of the data file must contains ids, cids and val-
ues, indicating the three columns containing the enities, variables and corresponding value, respectively. Coordinates
can be provided in a similar way under the variable names longitudes and latitudes.

Variable names can be provided inline, that is, simply by using the name of the variable for each entry involving it.
Alternatively, variable names can be specified separately with a special “-1” entity. Similarly, entity names can be
provided inline or separatly with a special “-1” variable. For example, the following four lines

Espoo; population; 260981
Helsinki; population; 614074
Tampere; population; 220609
Turku; population; 182281

are equivalent to the following:

20; —-1; Espoo

7; -1; Tampere

2; —1; Turku

13; —-1; Helsinki
-1; 3; population
2; 3; 182281

7; 3; 220609
13; 3; 614074
20; 3; 260981

Finally, in case of fully Boolean data without coordinates, the value can be left out. Each pair of (entity, variable)
appearing is considered as True, the rest as False.

4.2 Redescriptions formats

The product of redescription mining is a list of redescriptions. A redescription consist of a pair of queries over the
variables describing the entities, one query for each set. The two sets of variables are arbitrarily called left-hand side
and right-hand side, and so are the corresponding queries.

4.2.1 Supports
The support of a query is the set of entities for which the query holds. Any given redescription partitions the entities
into four sets:

* Ej is the set of rows for which only the left hand side query holds,

* Ey is the set of rows for which only the right hand side query holds,

12 Chapter 4. Formats
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* Ej is the set of rows for which both queries hold,
* and Ey is the set of rows for which neither of the queries hold.

Redescriptions can be imported to Siren via the interface menu File — Import — Import Redescriptions. More impor-
tantly, they can be exported via the interface menu File — Export Redescriptions. Below, we present the redescription
formats supported by Siren.

4.2.2 Queries

A query is formed by combining literal using Boolean operators.

While ReReMi only generate linearly parsable query (see references for more details), Siren can actually evaluates
arbitrary queries, as long as they are well formed following the informal grammar below. In particular, parenthesis
should be used to separated conjunctive blocks and disjunctive block, alternating between operators. For example,
while the later cannot be generated by ReReMi, (a Ab)V —c and (a Ab) V (¢ Ad) are both supported. (a Ab) A(cAd)is
not, because of incorrect alternance of operators between parenthesis blocks. It should simply be written as a AbAcAd.

We consider three types of literals, defined over a Boolean, categorical or numerical variable respectively.

Below is an unformal grammar of Siren‘s query language.

query = disjunction | conjunction | literal ;

conjunction = conj_item { ( “&” |7 N7 ) conj_item }+ ;

disjunction = disj_item { ( “1” 17V ” ) disj_item }+ ;

conj_item = literal | ( “(” disjunction ”)” ) ;

disj_item = literal | ( “(” conjunction ”)” ) ;

literal = categorical_literal | realvalued_literal | boolean_literal ;

categorical_literal = ( “[” )? variable_name cat (7 =717 #£7 17 € 1”7 €7 ) category ( “]” )? ;
realvalued_literal = [ neg | ( “[” )? [ variable_value Ith ] variable_name Ith variable_value ( “]” )? ;
realvalued_literal = [ neg | ( “[” )? variable_value Ith variable_name ( “]” )? ;

boolean_literal = [ neg ] ( “[” )? variable_name ( “]” )? ;

variable_name = STRING | ?/vd+/? ;

category = STRING | ?/d+/? ;

variable_value = ?/[+-]?d+([.])?d*([Ee][-+]d+)?/? ;

Ith=“<”17 <7 ;

neg = RN R ;

Naturally, the type of literal and the type of variable should match, i.e., [4.0 < Va < 8.32] is a valid numerical literal
only if the corresponding variable Va is a numerical variable. Furthermore, the upper bound of a numerical variable
should always be greater or equal to the lower bound and either of them should be specified.

4.2.3 Redescription statistics

The statistics of a redescription include:
* accuracy, as measured by Jaccard coefficient |E11|/(| E1o| + |E11] + |Eo1]),
* p-value,

e cardinality of the support sets E1g, Eo1, E11, Eoo (sometimes also referred to as alpha, beta, gamma and delta,
respectively).

4.2. Redescriptions formats 13
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4.2.4 Exporting Redescriptions
Redescriptions from the Redescriptions tab can be exported to a file, one redescription per line, with both queries
and basic statistics tab separated. Three of formatting options are available, determined by the provided filename:

* named: Uses the names of the variables instead of variable ids in the queries. Activated if the filename matches
the pattern * [a—zA-Z] named [a-zA-Z] *.

« all By default disabled redescriptions will not be printed when exporting redescriptions. If the filename matches
the pattern x [a—zA-Z]all [a-zA-Z] *, disabled redescriptions will also be printed.

* tex Rather than tab separated format, if the filename as .tex extension, a tex file is produced that can be
compiled to obtain a table of the redescriptions. (Cannot be imported back)

Inside a siren package, the redescriptions are stored in tab separated format together with disabled status.

4.2.5 Importing Redescriptions

Tab separated formats can be imported into Siren, TeX cannot.
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FIVE

PREFERENCES

Preference parameters can be set via the interface menu Edit — Preferences.

An XML preferences file stores all non-default parameters.

5.1 Mining parameters

Mining parameters are specified here and can be set through the interface.

© e« Preferences

Basic| Scoring Advanced | Interface = Maps
—Types of queries —
Max number of variables: |4
LHs Literals: positive ¥ Negative [ |
LHS Operators: conjunction [ Disjunction &
RHS Literals: positive [ Negative ||
RHS Operators: Conjunction E/I Disjunction &
—Supports of queries —
Min contribution: [3 o
Minsupport: (150

Min uncovered: 500,

Cancel ResetToDefaults oK

5.2 Interface parameters

Interface parameters are specified here and can be set through the interface.

15
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Basic Scoring Advanced | Interface | Maps

E o
Verbosity: 4 ]

—Vizualizations —

Dotsize: 3 ]
Dotshape: g -
Detailed missing: | o =
ColorLHS! | gy
Color RHS: | gy
Color Intersection: | gy
cancel Resel | ResetToDefaults|  Apply oK

Pick a Colour

Red: [255 .
e o
o

TN
\ saturation: (100 .|
Value: [100 2|

Colour name: | #FF0000

[

Preferences
Basic  Scoring  Advanced  Interface | | Maps|

— Elements —

Map background transparency: (10 ]

Resolution: | cryge -

Projection: | pmiller cylindrical 9

Polygons:

Yes o

Map natural areas:
Map natural elements:
Map geopolitic elements:

Map imaginary circles:

seas [ continents [ lakes [
coasts [ rivers [

countries [ states [
parallels (] meridians [ ]

Line color: | gy
Sea color:
Land color:

cancel Reset | ResetToDefaults| Apply | OK
b

For instance, this allows to modify the appearance of the maps.
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5.3 Preferences file

The ouline of a preferences file for Siren and ReReMi is as follows:

<root>

<!--- start parameter —-->

<parameter>
<!--- parameter name -->
<name>max_red</name>
<!-—- parameter value —-->
<value>100</value>

</parameter>

<!--- end parameter -->

<!--- start another parameter -->

<parameter>
<name>neg_query</name>
<!-—— multiple choices parameters might have several values -->
<value>Positive</value>
<value>Negative</value>

</parameter>
<!--- end another parameter —-->
<!l-—— etc. —-——>

</root>

5.3. Preferences file 17
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